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Leer deg Stata (Ringdal & Wiborg, 2017) gir en mer omfattende innfering i
Stata med oppskrifter pa de fleste dataanalysene i Enhet og mangfold.
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Om Stata

Stata er en programpakke for analyse av kvantitative data. Den viktigste kon-
kurrent i Norge er SPSS som ble lansert allerede i 1960-arene, mens Stata er av
nyere dato. Den forste versjonen for PC ble lansert i 1985. Brukergrensesnittet
har blitt gradvis utviklet fra & vaere rent kommandobasert til & gjore mer bruk
av menyer og dialogbokser.

Et av Statas fortrinn framfor SPSS er at nye programmer laget av andre
brukere lett kan installeres ved hjelp av kommandoen ssc install. Denne
type programmer kan en finne ved & soke pé Internett eller i brukerforumet
STATALIST og i Stata Journal.

En annen styrke ved Stata er at nye statistiske teknikker blir tidlig lagt
inn i Stata eller er tilgjengelig som brukerprogrammer som kan installeres i
ettertid. Dette har likevel mest interesse for avanserte brukere. Alle brukere
vil etter hvert sette pris pa de gode mulighetene for a lage grafiske framstil-
linger og ikke minst kommandoen margins som pa en enkel mate kan be-
regne predikerte verdier fra de fleste statistiske teknikker og framstille dem

i diagrammer.

Bruk av skrifttyper
Itillegg til den vanlig teksten er kommandoer, filnavn og variabelnavn, samt
utskrifter trykt i Courier New. Menyvalg og nedvendige trykk pa tastaturet
er gjengitt med rod skrift.

Installering av Stata

Stata installeres fra setupstata 15.exe. Denne kan komme pa en CD eller
lastes ned. Den kan starte automatisk fra CD ellers mé en dobbeltklikke pé
filnavnet. Nar du kommer til Select Executable, velges den variant av Stata
du har lisens for. Den forste gang Stata startes vil det sporres etter lisens- og
aktoveringsnekkelen. Hvis denne godtas vil du fd spersmal om du vil under-
soke om, det finnes oppdateringer av Stata. Trykk OK og felg instruksjonene
pa skjermen. Dermed er det gjort.



Vinduene verktgylinjen og menyene

Skjermbildet som meter deg (figur 1) utgjeres av fem vinduer. Over vinduene
tinnes verktoylinjen og menyene. Det storste vinduet er resultatvinduet eller
utskriftsvinduet som etter hvert vil fylles av «output» fra Stata. I «review»-
vinduet, helt til venstre, gjengis utferte kommandoer. Under resultatvinduet
er kommandovinduet, som framstar som en linje der det kan skrives kom-
mandoer. @verst til hoyre er variabelvinduet som viser variablene i datasettet.
Under dette er egenskapsvinduet som viser egenskapene (properties) til den
variabel som er valgt i variabelvinduet. Ikonene i verktoylinjene er kortkom-

mandoer for flere av mulighet

ene i menyene.
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Figur 1Hovedskjermbildet i Stata

I mange situasjoner trenger vi hjelp i Stata. Hjelpmenyen har hele ti valg.
Det forste er PDF-documentation som gir de fullstendige Stata-manualene i
PDF-format. Ellers kan vi blant annet sgke etter nokkelord og kommandoer.
Kommandoen help contents dpner vinduet i figur 2.
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Figur 2 «Help contents»-vinduet

Filtyper i Stata

Datafiler eller datasett som abug9.dta har dta som «etternavn», men filene
blir normalt gjenkjent uten etternavnet. Do-filer er samlingen av komman-
doer eller programmer som kan utfores fra denne type filer. Do-filer ber bru-
kes av alle som trenger en dokumentasjon pé det som er utfort, for eksempel
omkodinger og statistiske analyser. Stata grafer har etternavn gph. Det finnes
mange eksempler, slik som histogrammer og spredningsdiagrammer, i Enhet
og mangfold. Det er ogsé mulig a lagre det som skrives til resultatvinduet i en
log-fil, men jeg synes ikke dette er saerlig nyttig. Det er bedre & kopiere det en
vil beholde fra resultatvinduet til en word-fil eller liknende.

Apne og beskrive et datasett

Filer kan apnes og lagres ved hjelp av de to forste ikonene eller ved bruk av
tilmenyen: File > Open og File > Save. En dpner et datasett ved forst velge
File > Open, deretter lete seg fram til mappen og velge det datasett en gnsker
aapne, for eksempel abug9.dta. Nér Stata installeres folger noen datafiler som
benyttes i eksempler med. Disse dpnes med kommandoen sysuse. Datasettet
auto apnes med a skrive kommandoen sysuse auto. Kommandoen sysuse
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dir eller menyvalgene File > example datasets, gir en oversikt over denne
type filer. Stata gjor det ogsa mulig 4 apne filer som er lagret andre steder, for
eksempel pa Fagbokforlagets nettside. Denne kommandoen ble benyttet til
a dpne datasettet abug9:

use "https://nedlasting.fagbokforlaget.no/stata/abu89.dta", clear

Hvis vi onsker a lage et nytt datasett for & registrere data direkte i Stata, ma
Stata forst startes uten noen datafil. Deretter ma «Data Editor» apnes. Dette
gjores fra Data-menyen: Data > Data Editor - Data Editor (Edit). Alternativt
kan vi trykke pa det andre ikonet med en blyant (rett under statistikkme-
nyen). Dette dpner en tom datamatrise der vi kan skrive inn data direkte.
Variablene gir automatisk navn: vari, var2 osv. Disse kan endres i egenskaps-
vinduet, der ogsa verdietiketter kan legges til. Mer at det skilles mellom store
og smé bokstaver i variabelnavn. Det vil siat var1 ogvar1 er to ulike variabel-
navn. Derfor anbefales det helst a benytte bare sma bokstaver i variabelnavn.
Hvis en fil er importert fra en annen programpakke, kan det veere nyttig a
sorge for at alle variabelnavn endres til sma bokstaver slik:

rename all, lower

I figur 1 gir variabelvinduet en liste over variablene i filen. Det er flere mater &
enkelt beskrive disse pa. Menyvalgene Data - Describe data > Describe data
in memory or in a file &pner en dialogboks som gir flere valgmuligheter. Si-
den filen har fi variabler, er det bare & trykke pa OK. Resultatet er utskriften
nedenfor som gir en kort oversikt over variablene i datafilen.
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. describe

Contains data from https://nedlasting.fagbokforlaget.no/stata/abu89.dta

obs: 4,127

vars: 9 4 Jan 2018 12:38

size: 297,144 (_dta has notes)

storage display value

variable name type format label variable label

io_nr double %10.0g IO-nummer

time89 double %10.0g Gjennomsnittlig timelgnn 1989
ed double $10.0g Ar utdanning
age double %10.0g Alder
female double %10.0g Respondentens kjgnn
klasse89 double %28.0g klasse89 Goldthorpe klasse 1989
promot double %11.0g promot Noen gang forfremmet
fexp double %10.0g Bedriftserfaring
private double %10.0g private Privat sektor

Kommandoen describe gjor det samme. Prov & skrive denne i kommando-
vinduet. Hvis filen har mange variabler, kan vi velge de vi vil beskrive i dia-

logboksen, eller i en kommando:
describe time89-private /* time89 til private */
describe time89 ed /* time89 og ed */

Siste del av linjene viser hvordan forklarende tekst (kommentarer) kan legges
til en kommando.

Det framgar av utskriften at datasettet inneholder «notes», det vil si no-
tater som kan gi informasjon i tillegg til variablene. Disse vises enklest ved &
skrive kommandoen notes som utferes ved a trykke pa ENTER. Utskriften
nedenfor viser bade kommandoen og de tre notatene.

. notes

1. Data fra Arbeidstaker- og bedriftsundersgkelsen 1989. Statistisk Sentralbyra

2. Torp, H. and K. H. Skollerud (1990). Organisasjon, arbeidsmiljg og mobilitet: resultater
fra Arbeids- og bedriftsundersgkelsen. Oslo, Institutt for samfunnsforskning.

3. Faye, A. (1992). Arbeidsmiljg 1989. Oslo, Statistisk sentralbyra.
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Se pd og endre en datafil

Det seg gjore bade a se pa innholdet i en datafil og gjere endringer. Et trykk
pa ikonet med blyant midt under statistikkmenyen &pner vinduet i figur 1.3.
Der kan vi bade se pa og endre data. Vi kan merke oss at for variablene som
har verdietiketter slik som k1asse89, vises bare etikettene og ikke tallkodene.
Videre ser vi at «.» angir manglende data. Det er mulig a skille mellom ulike
typer manglende data ved a legge til en bokstav, for eksempel «.d»

[ Data E ] = o
File Edit View Data Tools
Fde DaEHA v,
io_nr(4] |2
io_nr timesd ed age female klassegd promot. A Variables 1
1 3 62 o se 1 III Rutinefunksjonarer NEI
2] 4 i 24 [} VIIa Ufaglerte arbeidere By Label ~
3 S 91.328947 3 44 1 II Nedre serviceklasse a = |0-nummer )
Gjennomsnittlic
4 E] 24.23913 s 46 1 II Nedre serviceklasse NEI ~
Ar utdanning
s 11 90.425532 3 40 0 II Nedre serviceklasse NEI Alder 9
6 12 103.20947 1 36 0 II Nedre serviceklasse NEI < >
7 13 75 ] 31 1 VIIa Ufaglarte arbeidere NEI { Verisbies j{onepsfiots
] 14 110.11905 7 31 0 I ovre serviceklasse NEI Properties 2
9 16 79 3 26 0 V-VI Faglerte arbeidere A B Variables A
Name io_nr
10 17 112.16216 9 29 0 I ovre serviceklasse NEI
Label 10-nummer
1 18 ©9.864865 0 s4 1 III Rutinefunksjonsrer an Type double
12 19 9 se [ I Ovre serviceklasse a Format %10.0g
Value label
13 20 50 1 25 0 V-VI Faglerte arbeidere NEI
Vv @ Notes
< > 8 Data v
Ready Vars:9 Order: Dataset  Obs:4127  Filter: Off  Mode: Edit  CAP

Figur 3 Statas Data Editor(Edit)

A lage en enkel tabell i Stata

I Enhet og mangfold finnes det oppskrifter pd hvordan tabeller lages, hvordan
korrelasjonsanalyser gjores, og hvordan en enkel varians- eller regresjonsana-
lyse kan utfores i Stata. Her skal vi bare gjennomga hvordan enkle tabeller kan
bestilles fra datafilen abug9. La oss se pa fordelingen pa kjenn. Velg Statistics
- Summaries, tables, and tests > Frequency tables > One-way table for a
apne «tabulatel»-dialogboksen der en kan velge variabler, for eksempel fe-
male. Deretter trykker vi pa OK, og frekvenstabellen for kjenn blir sendt til

resultatvinduet gjengitt i utskriften.
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. tabulate female

Respondente
ns kjgnn Freq. Percent Cum.
0 2,193 53.14 53.14
1,934 46.86 100.00
Total 4,127 100.00

Qverst i utskriften gjengis kommandoen som ble generert av menyvalgene.
Deretter folger tabellen som viser at variabelen har verdien 0 og 1. Verdie-
tiketter mangler, men kvinner har koden 1 og menn koden 0. Den neste
kolonnen viser antall menn og kvinner. Deretter folger den vanlige og den
kumulative prosentfordelingen. Utskriftene har en tendens til & bli lange, og
derfor er det oftest ikke hensiktsmessig a lagre filen i sin helhet. En enkel mate
er & velge tabellen(e) en vil kopiere, hoyreklikke, og velge Copy as picture.
Tabellen kan sa limes inn i Word. Den ser ut som pé skjermen, men den kan
ikke redigeres. En mate a fa dette til pa er & lage en tabell i Word, med tilstrek-
kelig antall rader og kolonner. I vart tilfelle fungere det bra med 4 kolonner
og 7 linjer (siden de horisontale strekene krever en linje hver). Marker sa
hele tabellen og velg lim inn. Pa lignende mate kan tabeller kopieres til Excel.
Noen ganger er det enklest bare & kopiere linjene med tall fordi resultatet i

kompliserte utskrifter ellers kan bli rotete.

Kommandoer for redigering av variabler

Her skal vi se pa hvordan vi kan endre pa variablene i en datafil. De to mest
interessante kommandoene er generate 0g recode. Den forste endrer eller
lager nye variabler ved hjelp av matematiske operasjoner. La oss se hvordan
vi kan lage ny variabel 1ntime89, som den naturlige logaritmen av times9,
timelgnn i 1989. Figur 4 viser hvordan «Generate»-dialogboksen ma fylles
ut for a lage den nye variabelen. Dialogboksen épnes ved a velge: Data >
Create or change data > Create new variable. For a lage uttrykket som lager
den nye variabelen ma vi trykke pa Create og dobbeltklikke pa In( ) som ma-
tematisk funksjon under Category i Expression Builder, og fylle time89 inn
i parentesen. Trykk OK for &8 komme tilbake til «generate»-dialogboksen og
trykk OK for a lage den nye variabelen. Deretter kan variabeletikett legges til
ved & velge 1time89 i Variabelvinduet og fylle inn etiketten i «Label»-linjen i
egenskapsvinduet.
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[] generate - Create a new variable — X
Main  if/in

Variable type: Variable name:
R

Contents of variable
@ Specify a value or an expression
] In(time89) I Create... \

O Fill with missing data

Position of new variable:
\Add at the end of dataset v

[] Attach value label:

@ E [il | oK || Cancel || Ssubmit

Figur 4 «Generate»-dialogboksen

«Recode»-dialogboksen kan benyttes til 8 omkode en variabel under samme
navn, eller lagre endringen i en ny variabel. Variabelen ed er antall ar ut over
obligatorisk utdanning. Verdiene varierer fra 0 til 11. Dette kan bekreftes ved
a lage en frekvenstabell pa samme mate som for kjonn. La oss lage en ny ut-
danningsvariabel, ed2, som bare skiller mellom lav (0-4 ar) og hey utdanning
(5-114r). Vi apner dialogboksen ved a velge Data > Create or change data >
Other variable-transformation commands - Recode categorical variable. Pa
figur 5 er ed valgt som variabelen som skal omkodes. I linjen midt i figuren
er omkodingen definert: 0-4 = 0, og 5-11 =1. De nye verdiene har ogsa fatt
etiketter. Hvis vi na trykker pa OK eller Submit vil de nye verdiene erstatte
de originale, mens vi ensker a beholde den gamle variabelen og lage en ny
omkodet variabel. Dette gjores ved & velge «Options»-fanen og skrive inn
den nye variabelen, «ed2», under Generate new variables. For a utfore kom-
mandoen trykker vi OK. Det er alltid lurt & kontrollere at omkodingen er
korrekt. Dette kan gjores ved a lage en krysstabell slik som vist i utskriften. I
«tabulate»-kommandoen er den originale variablene definert som linjevaria-

bel og den omkodede som kolonnevariabel. Kommandoen kan ogsa utfores
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fra Statistikk-menyen: Statistics > Summaries, tables and tests - Frequency
tables - Two way table with measures of association. I dialogboksen velges
ed som Row variable og ed2 som Column variable.

=] recode - Recode categorical variables = X
Main  if/in  Options
Variables:
ed [
Choose rule formats to edit or construct your own rules: ‘7 Examples... \
Required:
Optional:
(0/4) = 0 Lav)(5/11 = 1 Hey) i
v
v
v
v
CRREE [ok ]| cancel || submit

Figur 5 «<Recode main»-dialogboksen i Stata inn her

. tabulate ed ed2

RECODE of ed (Ar

Ar utdanning)
utdanning Lav Hoy Total
0 839 0 839
1 1,156 0 1,156
3 1,121 0 1,121
5 0 483 483
7 0 308 308
9 0 205 205
11 0 15 15
Total 3,116 1,011 4,127

Legge til verdietiketter (value labels)

Variabelen female (kjonn) manglet verdietiketter. Vi har allerede sett hvordan
verdietiketter enkelt kan legges til «recode»-kommandoen, men framgangs-
maten er mer tungvint for eksisterende variabler. I variabelvinduet ma en
forst velge female. I egenskapsvinduet (Properties) er «Value labels»-feltet
for female tomt. Merk at for vi kan gjore endringer er det nedvendig a apne
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hengelasen overst i egenskapsvinduet. Et trykk pé «...» dpner «Create label»-
dialogboksen i figur 6. Forst ma «Label name» defineres. Det er lurt & benytte
samme navn som variabelen. Deretter fyller vi inn «0» under Value:», skriver
«Menn» under Label: og trykker pa ADD. Gjenta for verdien «1» med «Kvin-
ner» som etikett, trykk pa ADD, og avslutt med OK. Dermed er verdietiket-
tene definert, men det gjenstar a tilordne dem variabelen female.

Create label X
Label name:

l female

Value | Label Value:

0 Menn [ 1]

1 Kvinner Label:

i <not defined>

| New | | Delete | Add

Note: Changes are not applied to the dataset until you dick OK.

| ok || cnca |

Figur 6 «Create label»-dialogboksen
Etter at dialogboksen er lukket, ma en trykke pa haken i «Value label»-feltet
og velge «female» som verdietikettsett. For a kontrollere at dette virker, kan

en skrive denne kommandoen i Kommandovinduet og avslutte med Enter.

tabulate female

I den nye tabellen vises bare verdietikettene. Denne kommandoen viser bare
tallkodene:

tabulate female, nolabel
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Det lar seg ogsé gjore a legge tallkodene til verdietikettene. Den forste kom-
mandoen gjor det for alle variabler, den andre gjor det bare for kjonn, og den
tredje fjerner tallkodene.

numlabel, add
numlabel female, add

numlabel, remove

Do-filer i Stata
Denne filtypen benyttes til a lagre kommandoer som kan utferes fra filen.
Do-filer gjor det mulig & utfere programmer som streker seg over mange
linjer. Do-filer fungere ogsa som en dokumentasjon av gjennomforte omko-
dinger og analyser og som et redskap for a gjenskape disse hvis analysefilen
av en eller annen grunn gar tapt.

La oss se hvordan kommandoene som er utfert i dette kapitlet kan lagres
i en do-fil. Ferst mé en ny do-file dpnes. Dette gjores ved a trykke pa det for-
ste ikonet med en blyant i verktoylinjen. Dette apner Do-file Editor med en
tom fil som automatisk blir gitt navnet untitled1.do. Deretter kopierer vi de
utforte kommandoene fra «Review»-vinduet. Det kan lenne seg a slette de
som ikke skal med i do-filen forst. Velg en eller flere linjer i do-filen og utfor
dem ved a trykke pé det siste ikonet med en bla trekant i verktoylinjen for &
utfore kommandoen(e) («Execute selection»).

Do-filen har ingen eksempler pa en kommando som strekker seg over
flere linjer, men her er et eksempel i form av en omkoding av alder:

recode age (16/19=1 16-19)(20/29=2 20-29)(30/39=3 30-39) ///
(40/49=4 40-49) (50/59=5 50-59)(60/74=6 60-74), gen(age6)

Forste linje avsluttes med de obligatoriske tre skrastrekene «///» som viser at
kommandoen fortsetter i neste linje.
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* Do-fil med Stata-kommandoer

use "https://nedlasting.fagbokforlaget.no/stata/abu89.dta", clear
* Oversikt over variablene i filen

describe /* alle variabler */

describe time89-private /* time89 til private */
describe time89 ed /* time89 og ed */

* Frekvenstabell for kjenn

tabulate female

* Lage en ny variabel med generate

generate lntime89 = 1ln(time89)

* Omkode ed (utdanning i &r) til ed2 med to verdier
recode ed (0/4 = 0 Lav)(5/11=1 Hey), generate(ed2)
tabulate ed ed2

** Definere verdietikettsettet female

label define female 0 "Menn" 1 "Kvinner"

* Knytte verdietikettsettet til variabelen female
label values female female

tabulate female

tabulate female, nolabel

* Legge tallkodene til verdietikettene for female
numlabel female, add

tabulate female

* Legge tallkodene til verdietikettene for alle variabler
numlabel, add

tabu klasse89

* Fjerne tallkodene fra verdietikettene

numlabel, remove

* Beskrivende statistikk for alle variablene

summ

Legge til kommentarer i Stata
Etter at kommandolinjene er limt inn i do-filen, er det nyttig & legge til kom-

mate:

describe /* alle variabler */

mentarer som forteller hva kommandoene utforer. Alle linjer som starter
med «*» blir oppfattet som kommentarer. Disse vises med grenn skrift, mens
kommandoene har bla skrift. Kommandoer i en linje omsluttes pa en spesiell

13
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Merk at kommentaren starter med «/*» og avsluttes med de to regnene i
motsatt rekkefolge. Det er flere eksempler pa begge typer kommentarer i
tekstboksen.

Beskrivende statistikk

Vi skal avslutte med a se pé hvordan vi kan lage en tabell med alle eller ut-
valgte variabler i en datafil. Den aktuelle kommandoen i Stata er summarize
eller bare summ. Do-filen gjengitt i tekstboksen avsluttes med to «summarize»-
kommandoer. Den forste uten variabelliste gir beskrivende statistikk for alle
variablene. Dette kan ogsa gjores fra menyene. Menyvalgene Statistics >
Summaries, tables and tests > Summary and descriptive statistics > Sum-
mary statistics apner «summarize»-dialogboksen (figur 7). Under Variables:
kan en velge variabler. Hvis vi ikke velger noen, blir det laget en tabell for alle
variablene. Dette gir den forste «<summaries»-kommandoen i do-filen. Den
siste kommandoen i do-filen gir beskrivende statistikk for alle variablene

unntatt den forste. Denne er gjengitt i utskriften nedenfor.

summarize - Summary statistics — X
Main  by/if/in Weights

Variables: (leave empty for all variables)
[ (V][]

Examples: yr* all variables starting with “yr"

xyz-abc all variables between xyz and abc

Options

(@ Standard display

QO Display additional statistics

(O No display; just calculate mean

[J Use variable's display format
5 }—:—: Separator line every N variables (set 0 for none)

[ Factor-variable display options 1

‘0 @} ‘D [ok || Cancel |[ Submit '\‘

Figur 7 «Summarize»-dialogboksen
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summarize time89 - lntime89
Variable Obs Mean Std. Dev. Min Max
time89 3,759 90.14948 30.31473 25 343.75
ed 4,127 2.689605 2.557027 0 11
age 4,127 39.65084 12.35712 16 74
female 4,127 .4686213 .4990749 0 1
klasse89 4,042 3.021029 1.186329 1 5
promot 4,127 .3777562 .484885 0 1
fexp 4,127 .9450933 .9065842 0 4.9
private 4,127 .6118246 .4873939 0 1
1ntime89 3,759 4.452624 .3076192 3.218876 5.839915




